|
INSTALLATION GUIDE

BNC-2120

Connector Accessory for E/M/S Series Devices

This installation guide describes how to install, configure, and use your BNC-2120 accessory with
68-pin or 100-pin E/M/S Series multifunction data acquisition (DAQ) devices. This document also
contains accessory specifications.
The BNC-2120 has the following features:
¢ Eight BNC connectors for analog input (AI) connection
*  Onboard temperature reference
¢ Thermocouple connector
e Resistor measurement screw terminals
*  Two BNC connectors for analog output (AO) connection
o Screw terminals for digital I/O (DIO) connection with state indicators
. Screw terminals for timing I/O (TIO) connection
e Two user-defined BNC connectors
* A function generator with the following outputs:
—  Frequency-adjustable, TTL-compatible square wave
—  Frequency- and amplitude-adjustable sine wave or triangle wave
¢ Quadrature encoder
e A 68-pin I/O connector that connects to multifunction DAQ devices

*  Can be used on a desktop or mounted on a DIN rail
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Conventions

The following conventions are used in this document:

<>

»

> @

bold

italic

monospace

Angle brackets that contain numbers separated by an ellipsis represent a range of values
associated with a bit or signal name—for example, AO <3..0>.

The » symbol leads you through nested menu items and dialog box options to a final action.
The sequence File»Page Setup»Options directs you to pull down the File menu, select the
Page Setup item, and select Options from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss,
or a system crash. When this symbol is marked on a product, refer to the Read Me First: Safety
and Radio-Frequency Interference document for information about precautions to take.

Bold text denotes items that you must select or click in the software, such as menu items and
dialog box options. Bold text also denotes parameter names.

Italic text denotes variables, emphasis, a cross-reference, or an introduction to a key concept.
Italic text also denotes text that is a placeholder for a word or value that you must supply.

Text in this font denotes text or characters that you should enter from the keyboard, sections
of code, programming examples, and syntax examples. This font is also used for the proper
names of disk drives, paths, directories, programs, subprograms, subroutines, device names,
functions, operations, variables, filenames, and extensions.

What You Need to Get Started

To set up and use your BNC-2120 accessory, you need the following:

a
a
a

U000 DU

a

BNC-2120 accessory/accessories!
BNC-2120 Installation Guide
One of the following DAQ devices:

—  68-pin E/M/S Series device (with one or two I/O connectors)?

—  100-pin E Series device

Cable(s) for DAQ device(s), as listed in Table 1

The E Series User Manual, the M Series User Manual, or the S Series User Manual
BNC cables

28-16 AWG wire

Wire strippers

Flathead screwdriver

Installing the BNC-2120

Figure 1 shows the front panel of the BNC-2120.

I You can use two BNC-2120 accessories with both connectors of NI 6224/6229/6254/6259/6284/6289 M Series devices.
2 You cannot use the BNC-2120 with Connector 1 of NI 6225/6255 devices.
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Figure 1. BNC-2120 Front Panel
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To connect the BNC-2120 to your DAQ device, complete the following steps. Consult your computer or
PX1/PXI Express chassis user manual for specific instructions and warnings.

Note If you have not already installed your DAQ device, refer to the DAQ Getting Started Guide for
instructions.

A Caution Do not connect the BNC-2120 to any device other than National Instruments E/M/S Series
multifunction DAQ devices. Doing so can damage the BNC-2120, the DAQ device, or the host
computer. National Instruments is not liable for damage resulting from these connections.

1. Place the BNC-2120 near the host computer or PXI/PXI Express chassis or use the optional DIN
Rail Mounting kit for UMI-FLEX-6 and BNC boxes (part number 777972-01), which you can
order from National Instruments at ni . com.

A Caution Do not connect input voltages greater than 42.4 V,,,/60 VDC to the BNC-2120. The
BNC-2120 is not designed for any input voltages greater than 42.4 V,/60 VDC, even if a
user-installed voltage divider reduces the voltage to within the input range of the DAQ device. Input
voltages greater than 42.4 V,,,/60 VDC can damage the BNC-2120, all devices connected to it, and
the host computer. Overvoltage can also cause an electric shock hazard for the operator. National
Instruments is not liable for damage or injury resulting from such misuse.

2. Connect the BNC-2120 to the DAQ device using the appropriate cable for your DAQ device,
as listed in Table 1.

Table 1. BNC-2120 Cabling Options

Number of Pins DAQ Device Recommended Cable(s)

68-pin DAQCard E Series, SHC68-68-EPM or RC68-68
NI PCI/PCle/PXI/PXIe M Series”
NI 6143 S Series

PCI/PXIE Series, SH68-68-EPM or R6868
USB Mass Termination M Series”,
NI 611x/612x/613x S Series’

100-pin PCI/PXI E Series SH1006868

* You cannot connect the BNC-2120 to Connector 1 of NI 6225/6255 devices.
T Do not use the R6868 cable with NI 6115/6120 S Series devices; use only the SH68-68-EPM cable.

The power indicator LED, shown in Figure 1, lights. If it does not light, check the cable
connections.

3. Launch Measurement & Automation Explorer (MAX), confirm that your DAQ device is
recognized, and configure your device settings. Refer to the DAQ Getting Started Guide for more
information.

4. Connect signals to the BNC connectors and screw terminal block as described in the following
sections.

@ Note With NI-DAQmx, National Instruments has revised its terminal names so they are easier to
understand and more consistent among NI hardware and software products. The revised terminal
names used in this document are usually similar to the names they replace. For a complete list of
Traditional NI-DAQ (Legacy) terminal names and their NI-DAQmx equivalents, refer to the
Terminal Name Equivalents table in the NI-DAQmx Help.
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5. Test specific device functionality, such as the ability to send and receive data with MAX test panels.
Refer to the DAQ Getting Started Guide for detailed information about running test panels in
MAX.

When you have finished using the BNC-2120, power oft any external signals connected to the
BNC-2120 before you power off your computer.

Connecting Analog Input Signals

You can use the analog input BNCs on the BNC-2120 in the following ways:

e  Measure differential Al signals, as described in the Connecting Differential Analog Input Signals
section

e Measure temperature, as described in the Measuring Temperature section

e Measure resistance, as described in the Measuring Resistance section

Connecting Differential Analog Input Signals

Use the BNC-2120 BNC connectors on the front panel to connect Al <0..7> signals to your DAQ device.
The BNC-2120 is only intended for differential analog input signals. The number of connectors you use
depends on your DAQ device and application. Complete the following steps to measure a differential
(DIFF) analog input signal.

1. Connect the BNC cable to one of the Al <0..7> BNC connectors on the front panel.!

2. If you are using Al 0, move the BNC/Temp. Ref. switch to the BNC position.
If you are using Al 1, move the BNC/Thermocouple switch to the BNC position.
If you are using Al 3, move the RES/BNC switch to the BNC position.

3. Configure your software to measure the channel differentially.

4. Move the FS/GS switch to the applicable position, depending on whether you are measuring a
floating source (FS) or ground-referenced source (GS) analog input signal. Refer to the Measuring
Floating Signals and Measuring Ground-Referenced Signals sections for more information about
these signal sources.

Measuring Floating Signals

To measure floating signal sources, move the corresponding switch below the BNC connector to the FS
position. In the floating source switch position, the DAQ device’s amplifier negative terminal connects
to ground through a 4.99 kQ resistor, as shown in Figure 2. Refer to your DAQ device documentation
for more information about measuring floating signals.

! When using the BNC-2120 with Connector 1 of NI 6224/6229/6254/6259/6284/6289 devices, the Al <0..7> BNCs on the
BNC-2120 map to the Al <16..23> channels on the M Series device.
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DAQ Device

Signal BNC-2120 (Differential Input Mode)

Source

DL
10k

Figure 2. Measuring a Floating Signal Source

Measuring Ground-Referenced Signals

To measure ground-referenced signals, move the switch below the BNC connector for the Al channel
you are using to the GS position. Using the ground-referenced source switch position avoids ground
loops, as shown in Figure 3. Refer to your DAQ device documentation for more information about
measuring ground-referenced signals.

F

Figure 3. Measuring a Ground-Referenced Signal Source

DAQ Device
BNC-2120 (Differential Input Mode)

AI GND and AI SENSE signals are located at the analog input screw terminals of the BNC-2120. When
connecting signals to the screw terminals, use 28—-16 AWG wire with the insulation stripped to 0.28 in.

Measuring Temperature

You can measure temperature on the BNC-2120 with the temperature reference and thermocouple
connector.

To use the integrated circuit (IC) temperature reference on the BNC-2120, move the BNC/Temp. Ref.
switch above the AI 0 BNC to Temp. Ref. The integrated circuit (IC) temperature reference provides
built-in cold-junction compensation (CJC) through software. The IC sensor voltage is linearly
proportional to the sensor temperature where:

°C = Volts x 100
The sensor is accurate to 1.5 °C.

To use the thermocouple on the BNC-2120, move the BNC/Thermocouple switch above the Al 1 BNC
to Thermocouple. You can connect any type of thermocouple with a two-prong miniature or
subminiature male connector to the thermocouple connector.
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For more information on thermocouples and CJC, refer to the Developer Zone document, Taking
Thermocouple Temperature Measurements, by going to ni.com/info and entering the info code
rdtttm.

Measuring Resistance

You can measure resistance with the analog input screw terminals on the BNC-2120. Figure 4 is a
schematic representation of how the BNC-2120 measures resistance.

Screw BNC-2120
Terminals
D RES+ Al3
) Al GND
User Resistor Al SENSE

© RES-

) Al 11
10 kQ
0.5%

NV

Figure 4. Measuring Resistance on the BNC-2120

RES+ is internally connected to Al 3 and Vc. RES- is internally connected to Al 11. There is also a
10 kQ resistor between Al 11 and AI GND.

When connecting signals to the screw terminals, use 28—-16 AWG wire with the insulation stripped
to 0.28 in.
Complete the following steps to measure resistance.
1. Move the RES/BNC switch above the AI 3 BNC to the RES position.
2. Configure your software to measure Al 3 and Al 11 in referenced single-ended (RSE) mode.
3. Connect the resistor to the RES+ and RES- screw terminals.
You can measure resistors with values ranging from 100 Q to 1 MQ.
4.  Measure Ve on Al 3 and the voltage drop across the internal 10 kQ resistor on AI 11.

5. With these measurements, calculate the resistor value using the following formula:

VAIS_VAIII

Resistor Value = ——————
V11710 kQ)

Connecting Analog Output Signals

Use the AO <0..1> BNC connectors on the BNC-2120 front panel to connect analog output signals to
your DAQ device.! The number of connectors you use depends on your DAQ device and application.
Refer to your DAQ device documentation for information about the use of these signals.

I When using the BNC-2120 with Connector 1 of NI 6229/6259/6289 devices, the AO <0..1> BNCs on the BNC-2120 map to
the AO <2..3> channels on the M Series device.
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Using the Function Generator

The BNC-2120 has a function generator that produces sine or triangle waveforms and TTL-compatible
square waveforms. Use the switch below the Sine/Triangle BNC to select a sine wave or triangle wave
output for the connector. A TTL-compatible square wave is always present at the TTL Square Wave
BNC.

To adjust the frequency of the function generator, select your frequency range using the Frequency
Selection switch. You can select 0.1-10 kHz, 1-100 kHz, or 13—1000 kHz. The Frequency Adjust knob
adjusts the frequency within the preselected range for the sine or triangle wave and the TTL square wave
outputs.

The Amplitude Adjust knob adjusts the amplitude of the sine or triangle wave output up to 4.4 V.

Connecting Timing 1/0 Signals

Connect the timing I/O signals of your DAQ device to the PFI 0/P1.0 (AI START TRIG) BNC or the
timing I/O screw terminals on the BNC-2120. When connecting signals to the screw terminals, use
28-16 AWG wire with the insulation stripped to 0.28 in.

Table 2 describes the timing I/O BNC and terminal signals on the BNC-2120.

Table 2. BNC-2120 Timing I/0 BNC/Terminal Descriptions

BNC/Terminal

Description

PFI 0/P1.0

Programmable Function Input channel O or Port 1 Digital Input/Output channel 0

AI START TRIG (AI Start Trigger Signal)—As an output, this pin is the ai/StartTrigger
signal. In post-trigger DAQ sequences, a low-to-high transition indicates the initiation of
the acquisition sequence. In applications with pre-trigger samples, a low-to-high transition
indicates the initiation of the pre-trigger samples.

PULSES

UP/DN

Refer to the Using the Quadrature Encoder section for information about using these
terminals.

PFI11/P1.1

Programmable Function Input channel 1 or Port 1 Digital Input/Output channel 1

AI REF TRIG (AI Reference Trigger Signal)—As an output, this pin is the
ai/ReferenceTrigger signal. In applications with pretrigger samples, a low-to-high
transition indicates the initiation of the post-trigger samples. Al Reference Trigger
is not used in applications with posttrigger samples.

PFI 2/P1.2

Programmable Function Input channel 2 or Port 1 Digital Input/Output channel 2

AI CONV CLK (AI Convert Clock Signal)—As an output, this pin is the ai/ConvertClock
signal. A high-to-low edge on AI CONV indicates that an A/D conversion is occurring.

PFI 3/P1.3

Programmable Function Input channel 3 or Port 1 Digital Input/Output channel 3

CTR 1 SOURCE (Counter 1 Source Signal)—As an output, this pin is the CtrlSource
signal. This signal reflects the actual source connected to the general-purpose counter 1.

BNC-2120 Installation Guide 8 ni.com



Table 2. BNC-2120 Timing I/0 BNC/Terminal Descriptions (Continued)

BNC/Terminal

Description

PFI 4/P1.4

Programmable Function Input channel 4 or Port 1 Digital Input/Output channel 4

CTR 1 GATE (Counter 1 Gate Signal)—As an output, this pin is the Ctrl1Gate signal.
This signal reflects the actual gate signal connected to the general-purpose counter 1.

PFI 5/P1.5

Programmable Function Input channel 5 or Port 1 Digital Input/Output channel 5

AO SAMP CLK (AO Sample Clock Signal)—As an output, this pin is the ao/SampleClock
signal. A high-to-low edge on AO SAMP indicates that the AO primary group is being
updated.

PFI 6/P1.6

Programmable Function Input channel 6 or Port 1 Digital Input/Output channel 6

AO START TRIG (AO Start Trigger Signal)—As an output, this pin is the ao/StartTrigger
signal. In timed AO sequences, a low-to-high transition indicates the initiation of the
waveform generation.

PF17/P1.7

Programmable Function Input channel 7 or Port 1 Digital Input/Output channel 7

AI SAMP CLK (AI Sample Clock Signal)—As an output, this pin is the ai/SampleClock
signal. This pin pulses once at the start of each Al sample in the interval sample.
A low-to-high transition indicates the start of the sample.

PFI 8/P2.0

Programmable Function Input channel 8 or Port 2 Digital Input/Output channel 0

CTR 0 SOURCE (Counter 0 Source Signal)—As an output, this pin is the CtrOSource
signal. This signal reflects the actual source connected to the general-purpose counter 0.

PFI 9/P2.1

Programmable Function Input channel 9 or Port 2 Digital Input/Output channel 1

CTR 0 GATE (Counter 0 Gate Signal)—As an output, this pin is the CtrOGate signal.
This signal reflects the actual gate signal connected to the general-purpose counter 0.

PFI 12/P2.4

Programmable Function Input channel 12 or Port 2 Digital Input/Output channel 4

CTR 0 OUT (Counter 0 Output Signal)—As an input, this pin can be used to route signals
directly to the RTSI bus. As an output, this pin emits the CtrOInternalOutput signal.

PFI 13/P2.5

Programmable Function Input channel 13 or Port 2 Digital Input/Output channel 5

CTR 1 OUT (Counter 1 Output Signal)—As an input, this pin can be used to route signals
directly to the RTSI bus. As an output, this pin emits the CtrlInternalOutput signal.

PFI 14/P2.6

Programmable Function Input channel 14 or Port 2 Digital Input/Output channel 6

FREQ OUT (Frequency Output)—This output is from the frequency generator.

+5V

+5 V Power—These terminals are fused on the DAQ device and are self-resetting.
The current available depends on the product to which it is connected.

D GND

Digital Ground—This terminal supplies the reference for the digital signals at the
1/0O connector as well as the +5 VDC supply.

© MNational Instruments Corporation 9 BNC-2120 Installation Guide



Using the Quadrature Encoder

The BNC-2120 contains a mechanical quadrature encoder circuit that produces 96 pulses per encoder
revolution. Two outputs, PULSES and UP/DN, are at the screw terminals located below the quadrature
encoder knob.

PULSES outputs a pulse train generated by rotating the encoder shaft. It provides four pulses per one
mechanical click of the encoder. UP/DN outputs a high or a low signal indicating rotation direction.
When the direction is counterclockwise, UP/DN is low. When the direction is clockwise, UP/DN is high.

To use the quadrature encoder with counter 0 of the DAQ device, connect the PULSES terminal to PFI 8
and connect the UP/DN terminal to the P0.6 digital I/O terminal, the up/down pin of counter 0. To use
the quadrature encoder with counter 1, connect the PULSES terminal to PFI 3 and connect the UP/DN
terminal to the P0.7 digital I/O terminal, the up/down pin of counter 1. Refer to Table 2 for more
information about PFI 3 and PFI 8. Refer to the Connecting Digital I/0 Signals section for more
information about the digital I/O terminals and LEDs.

You can use the Count Digital Events VI from the LabVIEW Example Finder (Hardware Input and
Output»DA Qmx»Counter Measurements»Count Digital Events) with the BNC-2120 quadrature
encoder. After opening the VI, select Externally Controlled in the Count Direction control. The VI
retrieves the count from the counter. You can convert the count into total degrees rotated using the
following formula:

Total Degrees Rotated = PULSES x 3.75°/pulse
where
3.75%pulse = 360°/96 pulses

Calculate the number of revolutions and remaining degrees by dividing the total degrees rotated by 360°.
The calculated quotient is equal to the number of revolutions and the remainder is equal to the remaining
degrees.

Connecting User-Defined Signals

The USER 1 and USER 2 BNC connectors allow you to use a BNC connector for a digital I/O or
timing I/O signal of your choice. The USER 1 and USER 2 BNC connectors are routed (internal to
the BNC-2120) to the USER 1 and USER 2 screw terminals, as shown in Figure 5.

USER 1 BNC

®------ , Internal
' Connection

D GND L USER 1
USER2BNC '"t-* | USER2
P . Internal

Connection
D GND

Figure 5. USER <1..2> BNC Connections

Figure 5 shows an example of how to use the USER 1 and USER 2 BNCs. To access the PFI 8/P2.0
(CTR 0 SOURCE) signal from a BNC, connect USER 1 on the screw terminal block to PFI 8/P2.0 with
a28-16 AWG wire.
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TIMING 1/0
Screw Terminal Block
e | PFI8/P2.0
N\ PFl9/P2.1
PFIl 12/P2.4
Fl 13/P2.5
PN 14/P2.6
+5
D GND
Wire
__USER 1BNC
®------ , Interpal
' Connection
-[-d JUSER 1
PFI1 8
Signal

Figure 6. Connecting PFI 8 to USER 1 BNC

The designated space next to each USER <1..2> BNC is for marking or labeling signal names.

Connecting Digital 1/0 Signals

Connect to the digital I/O signals of your DAQ device to the digital I/O screw terminals, P0.<0..7>, on
the BNC-2120. You can individually configure each signal as an input or output. D GND is available at
the screw terminals to supply the reference for the DIO signals. When connecting signals to the screw
terminals, use 28—16 AWG wire with the insulation stripped to 0.28 in.

@ Note P0.6 and P0.7 can control the up/down signal of general-purpose counters 0 and 1,
respectively. Refer to the Using the Quadrature Encoder section for more information about

using the P0.6 and P0.7 terminals with the quadrature encoder.

The LEDs next to each screw terminal indicate the state of each digital line, as listed in Table 3.

Table 3. Digital I/0 LEDs

Digital I/O LED Digital Port State
Lit The port is either pulled high or driven high
Not lit The port is either pulled low or driven low

Specifications
This section lists the specifications of the BNC-2120. These specifications are typical at 25 °C unless
otherwise specified.

@ Note Refer to your DAQ device documentation for specifications about analog input, analog output,
trigger/counter, and digital and timing I/O signals.
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Analog Input

Number of channels (default) .............c..ccceeeeunean. 8 differential
Field connections (default) ............cccoeeveeiiieeneennns 8 BNC connectors
Protection.......ccoeveeieniinieneneneneneneeececeeeeieeene No additional protection provided.

Consult your DAQ device specifications.

Optional inputs
Temperature sensor

...Thermocouple

Resistor measurement (requires RSE configuration)

Optional connections

Thermocouple .........coeveverenenineninieeene Uncompensated miniature connector, mates with
2-prong miniature or subminiature connector
RESISIOT .. 2 screw terminals
Resistor measurement range .........c..ceceeeeveeeeeneennne 100 Q to 1 MQ
Resistor measurement error ..........ceceeeeeveeeeeeennne <5%
Screw terminals........coceveeveerieerienienieneeneeie e 4 positions, 28—-16 AWG wire
Switches
Floating source/grounded source .................. 8
BNC/temperature reference IC ..................... 1
BNC/thermocouple connector....................... 1
BNC/resistor screw terminals.............cc.ce.e... 1

Analog Output

Field connection............ccueevveeeveeecnieeiieeceeeeveeenns 2 BNC connectors

Digital Input/Output
Screw terminals.........occeveereerieerienienieneeneeee e 9 positions, 28—-16 AWG wire
LED state indiCators..........ccocveereveeerveeniieeeireeenneens 8, 1 each for lines P0.<0..7>

Protection (DC max V)

Powered off .. .55V
Powered on.........cccevevinininiiniieiiiciciencnee +10/-5V
Drive
Vgl ceveeereemeneiineete ettt 0.6V, 8 mA
1.6 V, 24 mA
V gheeveeereemeremtnennereineenereerie et 44V, 8 mA
4V, 13 mA
Function Generator
SQUATE WAVE ..ottt TTL-compatible
Frequency range..........coceeeeeeenenenieienennenes 100 Hz to 1 MHz
Frequency adjust.........ccceeevenenineninieienn Through the Frequency Adjust knob

BNC-2120 Installation Guide 12 ni.com



RiS€ tiMe ....oooveieiieeieceeeeee e 250 ns

Fall time

Sine/triangle wave

Frequency range ....100 Hz to 1 MHz

Frequency adjust.........ccceceevievieniencnicncncnene Through the Frequency Adjust knob
Amplitude range .........ccoceeecerenieeneineneene. 60mV, ,t04.4Vy,

Amplitude adjust........cccoeevierieniinienieneenens Through the Amplitude Adjust knob

Comparison Triangle wave is approximately 2 times
the sine wave output 4.4 V_, maximum

Output impedance ........cecuevververrereeeeeeneenenes 600 Q

Drive capability

—a—Square Wave (V)
—e— Sine/Triangle Wave (V)

1M 10 k 5k 2k 1k 560
Ohms

Figure 7. Typical Maximum Voltages versus Load Impedances

Timing Input/Output

Screw terminals.......c.coccveeeeerieinenieinreenenneennens 14 positions, 28—-16 AWG wire
BINC CONNECLOT ... 1, for PFI 0/AI START TRIG
Protection (DC max V)

Powered Off .......ccvevieieiieeieeeeeeeeee e +1.7V

Powered On........ccoeeeveeevieieeiieecieeeeeeeeee, +6.7/-1.7V

Quadrature Encoder

Screw terminals..........cccveeeviieeeieeeieenieeeee e 2

Output signals
PULSES ...t 96 pulses/revolution

UP/DNN et High for clockwise rotation,
low for counterclockwise rotation

© MNational Instruments Corporation 13 BNC-2120 Installation Guide



Power Requirement

+5 VDC (E5%) e 200 mA, sourced from the multifunction DAQ device

Power available at +5 V screw terminal ................ Multifunction DAQ device power,
less power consumed at +5 VDC (£5%)

Physical
DIimensions ........c.cceeereerieinicninencieeeneeeeeeeaene 26.7cmx 11.2cm X 5.97 cm
(10.5in. x 4.41 in. X 2.35 in.)
WeIGht ... 1,040 g (21b 4.7 0z)
1/O cONNECLOT ....oveiiiiiieeee e 68-pin male SCSI-II type
BNC cONNECtOrs.......cc.cvvuiiiiiiiiiiiiiciiicins 15
Screw terminal plugs.........cccoveeeveneeenreinecnnennenens 31
Environment
Operating temMperature ............coceeveerveereeeruensueninenne 0to 50 °C
Storage temMpPEerature .........oceeveevereeneeeneeneesuennnenne -55t0 125 °C
Relative humidity..........cccoeeinenniinciinciniicneens 5 to 90%, noncondensing
Pollution Degree (indoor use only)........c..ccceveenee 2
Maximum altitude........cccvveveveiuvieiiiiiieeceeeeeeenee. 2,000 m
Safety

5

This product is designed to meet the requirements of the following standards of safety for electrical
equipment for measurement, control, and laboratory use:

« IEC61010-1, EN 61010-1
« UL 61010-1, CSA 61010-1
Note For UL and other safety certifications, refer to the product label or visit ni . com/

certification, search by model number or product line, and click the appropriate
link in the Certification column.

Electromagnetic Compatibility

5

This product is designed to meet the requirements of the following standards of EMC for electrical
equipment for measurement, control, and laboratory use:

*  EN 61326 EMC requirements; Minimum Immunity
o EN 55011 Emissions; Group 1, Class A
. CE, C-Tick, ICES, and FCC Part 15 Emissions; Class A

Note For EMC compliance, operate this device with shielded cables.

BNC-2120 Installation Guide 14 ni.com



CE Compliance
This product meets the essential requirements of applicable European Directives, as amended for
CE marking, as follows:
e  2006/95/EC; Low-Voltage Directive (safety)

e 89/336/EEC; Electromagnetic Compatibility Directive (EMC)

@ Note Refer to the Declaration of Conformity (DoC) for this product for any additional regulatory
compliance information. To obtain the DoC for this product, visit ni.com/certification,
search by model number or product line, and click the appropriate link in the Certification column.

Environmental Management

National Instruments is committed to designing and manufacturing products in an environmentally
responsible manner. NI recognizes that eliminating certain hazardous substances from our products is
beneficial not only to the environment but also to NI customers.

For additional environmental information, refer to the NI and the Environment Web page at
ni.com/environment. This page contains the environmental regulations and directives with which
NI complies, as well as other environmental information not included in this document.

Waste Electrical and Electronic Equipment (WEEE)

E EU Customers At the end of their life cycle, all products must be sent to a WEEE recycling center.
i For more information about WEEE recycling centers and National Instruments WEEE initiatives,
visit ni.com/environment /weee.htm.

BFEEFRETREREEDE (FE ROHS)

&4y HEEP  National Instruments 74 [ 7 6% i B RS 5T 4 (ROHS).
*7F National Instruments 1 [E RoHS & MEPE(E S, %% 3% ni . com/environment /rohs_chinas
(For information about China RoHS compliance, go fo ni . com/environment/rohs_china.)
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National Instruments, NI, ni.com, and LabVIEW are trademarks of National Instruments Corporation.
Refer to the Terms of Use section on ni . com/legal for more information about National
Instruments trademarks. Other product and company names mentioned herein are trademarks or trade
names of their respective companies. For patents covering National Instruments products, refer to the
appropriate location: Help»Patents in your software, the patents . txt file on your CD, or
ni.com/patents.

© 1999-2008 National Instruments Corporation. All rights reserved.
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